ATLAS Cloud® System Requirements

Online Training and Assessment Services

<table>
<thead>
<tr>
<th>Project</th>
<th>ATLAS Cloud</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer</td>
<td>ATLAS Cloud Admin</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Author</th>
<th>PSI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation Date</td>
<td>10 May 2016</td>
</tr>
<tr>
<td>Last Review Date</td>
<td>15 December 2017</td>
</tr>
<tr>
<td>Electronic File Name</td>
<td>PSI_ATLAS Cloud System Requirements.docx</td>
</tr>
<tr>
<td>Information Category</td>
<td>Unclassified Public</td>
</tr>
</tbody>
</table>
## Revision History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>10 May 2016</td>
<td>Document created</td>
</tr>
<tr>
<td>1.1</td>
<td>24 June 2016</td>
<td>Document updated</td>
</tr>
<tr>
<td>1.2</td>
<td>13 October 2016</td>
<td>Document updated</td>
</tr>
<tr>
<td>1.3</td>
<td>29 November 2016</td>
<td>Document updated</td>
</tr>
<tr>
<td>1.4</td>
<td>5 December 2016</td>
<td>Document updated</td>
</tr>
<tr>
<td>1.5</td>
<td>9 January 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>2.0</td>
<td>9 January 2017</td>
<td>Document approved</td>
</tr>
<tr>
<td>2.1</td>
<td>14 March 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>3.0</td>
<td>14 March 2017</td>
<td>Document approved</td>
</tr>
<tr>
<td>3.1</td>
<td>28 March 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>3.2</td>
<td>11 April 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>4.0</td>
<td>11 April 2017</td>
<td>Document approved</td>
</tr>
<tr>
<td>4.1</td>
<td>28 April 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>5.0</td>
<td>5 May 2017</td>
<td>Document approved</td>
</tr>
<tr>
<td>5.1</td>
<td>12 June 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>6.0</td>
<td>12 June 2017</td>
<td>Document approved</td>
</tr>
<tr>
<td>6.1</td>
<td>15 August 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>6.2</td>
<td>1 September 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>6.3</td>
<td>22 September 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>6.4</td>
<td>9 October 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>7.0</td>
<td>10 October 2017</td>
<td>Document approved</td>
</tr>
<tr>
<td>7.1</td>
<td>12 December 2017</td>
<td>Document updated</td>
</tr>
<tr>
<td>8.0</td>
<td>15 December 2017</td>
<td>Document approved</td>
</tr>
</tbody>
</table>

## Approval Section

<table>
<thead>
<tr>
<th>Name</th>
<th>Position</th>
<th>Signature</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tom Masters</td>
<td>Head of Service Delivery</td>
<td></td>
<td>15 December 2017</td>
</tr>
</tbody>
</table>
Contents

Revision History ........................................................................................................................................ 2
Approval Section ......................................................................................................................................... 2
Contents ..................................................................................................................................................... 3
Introduction to ATLAS Cloud® Software Requirements .............................................................................. 6
ATLAS Cloud® Software Requirements (All users) ........................................................................................ 7
  Supported Operating Systems .................................................................................................................. 7
  Supported Screen Resolution ................................................................................................................... 7
  Supported Browsers .................................................................................................................................. 7
  Pop-up Blocker ......................................................................................................................................... 8
  Internet Connection .................................................................................................................................. 8
  Firewall Settings ...................................................................................................................................... 8
  Technician Checklist ................................................................................................................................. 8
  Other Settings – In-application tests only ................................................................................................ 8
Appendix A: In-application Testing – Additional requirements ....................................................................... 9
  System Requirements ............................................................................................................................... 9
    Operating System .................................................................................................................................. 9
    In-application Screen Resolution ......................................................................................................... 9
    .NET Framework ................................................................................................................................... 9
  Supported Microsoft Office ...................................................................................................................... 9
  Unsupported Microsoft Office .................................................................................................................. 10
    Microsoft Office 2007 ........................................................................................................................... 10
    Microsoft Office 2003 ........................................................................................................................... 10
  Other Office Versions .............................................................................................................................. 10
  Additional Microsoft Components ......................................................................................................... 11
    Service Packs ....................................................................................................................................... 11
    In-application Plugin ............................................................................................................................... 11
  Extensions ................................................................................................................................................ 11
  Access to Work Files ............................................................................................................................... 11
  Access to the Windows Registry ............................................................................................................... 12
  Printer Configuration (Required for all versions of Microsoft Office) ..................................................... 12
    Windows 8/10 ........................................................................................................................................ 12
    Windows 7 ............................................................................................................................................. 12
  Microsoft Office Language Versions ....................................................................................................... 12
  Windows Regional and Language Settings ............................................................................................... 13
  Anti-Virus ............................................................................................................................................... 13
  Support .................................................................................................................................................... 13
Appendix B: In-application Testing - Microsoft Edge .................................................................................. 14
Appendix C: In-application Testing - Other Microsoft Office Application Settings

Microsoft Office 2016
- Interface Settings for Microsoft Word 2016
- User Interface Settings for Microsoft Excel 2016
- Interface Settings for Microsoft Word and Excel 2016
- Macro Security Settings for MS Word, Excel and PowerPoint 2016
- Macro Security Settings for Microsoft Access 2016
- Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access 2016 (Optional)

Microsoft Office 2013
- Interface Settings for Microsoft Word 2013
- User Interface Settings for Microsoft Excel 2013
- Interface Settings for Microsoft Word and Excel 2013
- Macro Security Settings for MS Word, Excel and PowerPoint 2013
- Macro Security Settings for Microsoft Access 2013
- Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access 2013 (Optional)

Microsoft Office 2010
- Interface Settings for Microsoft Word 2010
- Interface Settings for Microsoft Excel 2010
- Interface Settings for Microsoft Word and Excel 2010
- Display Any Hidden Workbooks in Excel 2010
- Macro Security Settings for Microsoft Word, Excel, PowerPoint 2010
- Macro Security Settings for Microsoft Access 2010
- Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access 2010 (Optional)

Appendix D: Unsupported Operating Systems and Browsers

Unsupported Operating Systems
- Microsoft Windows XP
- Microsoft Vista

Unsupported Browsers
- Safari for PC
- Old Versions of Google Chrome
- Old Versions of Firefox

Appendix E: Technicians Checklist

Viewing the System Requirements Check Log
- View log link
- Show log button
- Copy logfile button

Checklist for All Users – Part 1
Introduction to ATLAS Cloud® Software Requirements

This document has been provided to help ensure the correct software requirements are being used for ATLAS Cloud. The main body of the document covers the requirements for all users. The specific requirements for in-application users are included in the appendices, which are referred to throughout the document.
ATLAS Cloud® Software Requirements (All users)

Supported Operating Systems

- Microsoft Windows 7/8/10 (32 and 64-bit)
- Apple Mac OS (and Mac OS X) 10.5.x, 10.6.x *

* Note that whilst item bank tests are supported on Apple Mac operating systems, there is no support for in-application tests. For more information on PSI in-application configuration, see Appendix A or contact PSI support at intl-support@psionline.com

Please refer to Appendix D for unsupported operating systems

Supported Screen Resolution

The recommended screen resolution is:

- **Non-test users** - at least 1024x768 pixels with 16k colours
- **All test users** - 1920x1080 pixels with 16k colours*

*Using this resolution will ensure that the on-screen area is large enough to support all types of test; however, the minimum screen resolution required will be dependent on the test content being delivered and in many cases a smaller screen resolution may be used. For further information see Appendix A

Supported Browsers

Please see below a list of supported web browsers (32 and 64-bit):

- Internet Explorer: Version 11 as noted below

  In line with Microsoft’s policy on browser support, only the following versions of Internet Explorer will receive support:

<table>
<thead>
<tr>
<th>Windows Desktop OS</th>
<th>Internet Explorer Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7 SP1</td>
<td>Internet Explorer 11</td>
</tr>
<tr>
<td>Windows 8.1 Update</td>
<td>Internet Explorer 11</td>
</tr>
<tr>
<td>Windows 10</td>
<td>Internet Explorer 11</td>
</tr>
</tbody>
</table>

- Firefox                  | Latest Version |
- Google Chrome             | Latest Version* |

*The latest version of Chrome must be used for the item banking audio capture (speaking) test question to work

We recommend that the default web browser is changed from Microsoft Edge to a web browser that is supported by ATLAS Cloud®. For in-application testing, it is essential that the web browser is changed from Microsoft Edge. Please see Appendix B for the steps required.

Please refer to Appendix D for unsupported browsers
Pop-up Blocker

If you use a pop-up blocker, pop-up windows must be allowed for *.psionline.com.

⚠️ Please note that if you use Windows 8 or Windows 10, Internet Explorer must be running in desktop mode to run a test.

Internet Connection

Download speed requirements are dependent on the number of concurrent users and usage patterns. As a rough guide, we recommend at least 512 Kbit/s per user, but no less than 10 Mbit/s of total available capacity *

⚠️ For test users, the largest files are typically downloaded at the start of a test, however this may vary with test type. Speed requirements may be increased if the test includes media objects or large work files.

Firewall Settings

ATLAS Cloud uses http and https. Any firewall or proxy must be configured to allow:

- HTTP access (destination TCP port 80, URLs begin with http://)
- HTTPS access (destination TCP port 443, URLs begin with https://)
- DNS lookups (TCP/UDP port 53, check your DNS server address)

Any firewall must also allow the downloading of .bin (Binary data) and .jar (Java Archive) files.

Technician Checklist

There is a one-page checklist on Appendix E Part 1 that can be used as an aide memoire for Technicians. This should be used in conjunction with the rest of this document, not as a standalone reference.

Other Settings – In-application tests only

There are other settings that are required for in-application tests only. These are:

1. Additional Requirements – for all additional system requirements for in-application tests only including plugin and extension, printer configuration, windows and language settings. For details of the full requirements, please refer to Appendix A and Appendix F
2. Change Microsoft Edge Browser – for the steps required to change the default browser from Microsoft Edge, please refer to Appendix B
3. Other Office Settings – for the settings required for each office version, please refer to Appendix C
4. Technician checklist – an aide memoire for any IT Technicians that are setting up machines prior to testing a Checklist has been provided in Appendix E Part 2. This is in addition to the Part 1 checklist required for all users
Appendix A: In-application Testing – Additional requirements

System Requirements

The following system requirements are for **in-application testing only**.

**Operating System**

Only Microsoft Windows operating systems can run an in-application test.

Microsoft Windows 7/8/10

**In-application Screen Resolution**

Using a resolution lower than 1920x1080 for in-application tests may result in a need to maximize the application in order to answer particular questions. Use of screen resolutions as low as 1024x768 is supported and will not prevent the test from functioning as expected; however, the candidate experience will not be as intended.

**.NET Framework**


A download link is also provided on the **System Requirements Check** page.

**Supported Microsoft Office**

In-application tests are available for the following Microsoft Office (32 and 64-bit) components:

- Microsoft Word
- Microsoft Excel
- Microsoft PowerPoint
- Microsoft Access (Professional and Professional Plus only)
- Microsoft Project 2010/2013
In-application tests are supported with the following editions of Microsoft Office:

**Microsoft Office 2016**
- Home and Student (2)
- Home and Business (2)
- Standard (2)
- Professional; Professional Plus;
- Office 365 Home (3); Office 365 Personal (3)

**Microsoft Office 2013**
- Home and Student (2)
- Home and Business (2)
- Standard (2)
- Professional; Professional Plus;
- Office 365 Home (3); Office 365 Personal (3)

**Microsoft Office 2010**
- Home and Student (2)
- Home and Business (2)
- Standard (2)
- Professional; Professional Plus

(1) PowerPoint and Access modules are not available.
(2) Access modules not available.
(3) Office 365 is only supported with a "Full, local installation". For more information, please click [here](#).

### Unsupported Microsoft Office

Please note that we no longer offer support for the following versions of Microsoft Office and Operating Systems:

**Microsoft Office 2007**

Microsoft Office 2007 ceased to be supported by Microsoft as of 10 October 2017 and therefore will cease to be supported as an operating environment for ATLAS Cloud.

**Microsoft Office 2003**

Microsoft Office 2003 ceased to be supported by Microsoft as of 8 April 2014 and therefore will cease to be supported as an operating environment for ATLAS Cloud.

**Other Office Versions**

Please note that Office Starter Edition, Office online and Trial editions of Microsoft Office are not supported.
Additional Microsoft Components

Service Packs

The latest Service Packs and updates for Microsoft Office must be installed. The most recent available Service Packs for Microsoft Office (English language versions) can be found here:

- **2016**: We recommend that the latest updates are installed, but there is no Service Pack requirement.
- **2013 Service Pack 1**: [https://support.microsoft.com/en-us/kb/2817430](https://support.microsoft.com/en-us/kb/2817430)

In-application Plugin

In-application testing requires the PSI In-application Plugin.

⚠️ To install the PSI In-application Plugin, please refer to the Appendix F

Extensions

The Plugin installation guide also covers the extensions required for Chrome and Firefox users as well as the requirement for the latest plugin.

Internet Explorer users only require the latest plugin installed.

Access to Work Files

Work files can be saved either to a virtual drive mapped to the temporary folder (default) or to the Documents folder.

When using a mapped drive (default, recommended):

- The virtual drive will be mapped to the last available drive letter on your local system (usually Z:).
- A Windows administrator can hide some drive letters by applying a Windows Group Policy (Hide these specified drives in My Computer). If the virtual drive is mapped to a hidden drive letter, the virtual drive will not be seen and will thus not function properly. Our recommendation is to use the default setting, which is to not hide any drives. See [http://support.microsoft.com/kb/231289](http://support.microsoft.com/kb/231289) for details.

When not using a mapped drive:

- The user must be allowed to save files to the Documents folder (the My Documents in older versions of Windows).
- The Documents folder must not be shared between multiple users taking ATLAS Cloud In-App tests at the same time.
Access to the Windows Registry

If Windows Registry access has been restricted for any reason, users must still be allowed normal read and write access to the Windows Registry areas where the users’ settings are stored (HKEY_CURRENT_USER). This is the default setting in Microsoft Windows for a non-administrator user.

Printer Configuration (Required for all versions of Microsoft Office)

ECDL/ICDL tests require that you have a functional printer and printer driver installed. Please perform the following steps on all computers used for testing.

Windows 8/10

1. Click the **Start** button, or press the `Enter` key
2. Type **Devices** and click **Devices & Printers**
3. Underneath the **Printers** section, ensure the green tick is marking a functional printer (you can test whether a printer is functional by using right click > Properties > Print test page)
4. If the required printer is on the list, but does **not** have the green tick covering it, right click the printer and click **Set as default printer**
5. If the printer does **not** reside within the list at all, then please follow the manufacturer’s instructions for installation

Windows 7

1. Click the **Start** button
2. Click **Devices and Printers**
3. Underneath the **Printers and faxes** section, ensure the green tick is marking a functional printer (you can test whether a printer is functional by using right click > Properties > Print test page)
4. If the required printer is on the list, but does **not** have the green tick covering it, right click the printer and click **Set as default printer**
5. If the required printer does **not** reside within the list at all, then please follow the manufacturer’s instructions for installation

Microsoft Office Language Versions

ECDL/ICDL Advanced tests are designed to be used with specific Microsoft Office user interface languages. The test language must match the Microsoft Office language.

<table>
<thead>
<tr>
<th>Test Language Suffix</th>
<th>Designed for the following MS Office Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eng</td>
<td>English (United Kingdom)</td>
</tr>
<tr>
<td>US Eng</td>
<td>English (United States)</td>
</tr>
<tr>
<td>CA Eng</td>
<td>English (Canada)</td>
</tr>
<tr>
<td>CH-Deu</td>
<td>German (Switzerland)</td>
</tr>
<tr>
<td>CH-Fra</td>
<td>French (Switzerland)</td>
</tr>
<tr>
<td>Ned</td>
<td>Dutch (Netherlands)</td>
</tr>
<tr>
<td>Rom</td>
<td>English (United States)</td>
</tr>
</tbody>
</table>
Windows Regional and Language Settings

ECDL/ICDL tests rely on certain formats in Windows Regional and Language Settings. The test language must match the formats of the language and country for which the test is designed. The formats are: Date format, Number format and Measurement system.

<table>
<thead>
<tr>
<th>Test Language Suffix</th>
<th>Designed for the following Windows Regional and Language Settings</th>
<th>Date Format (Short)</th>
<th>Number Format</th>
<th>Measurement System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eng/UK Eng</td>
<td>English (United Kingdom)</td>
<td>23/06/2011</td>
<td>123,456,789.00</td>
<td>Metric</td>
</tr>
<tr>
<td>US Eng</td>
<td>English (United States)</td>
<td>6/23/2011</td>
<td>123,456,789.00</td>
<td>U.S.</td>
</tr>
<tr>
<td>CA Eng</td>
<td>English (Canada)</td>
<td>23/06/2011</td>
<td>123,456,789.00</td>
<td>Metric</td>
</tr>
<tr>
<td>CH-Deu</td>
<td>German (Switzerland)</td>
<td>23.06.2011</td>
<td>123,456,789.00</td>
<td>Metric</td>
</tr>
<tr>
<td>CH-Fra</td>
<td>French (Switzerland)</td>
<td>23.06.2011</td>
<td>123,456,789.00</td>
<td>Metric</td>
</tr>
<tr>
<td>Ned</td>
<td>Dutch (Netherlands)</td>
<td>23-6-2011</td>
<td>123,456,789.00</td>
<td>Metric</td>
</tr>
<tr>
<td>Rom</td>
<td>English (United States)</td>
<td>6/23/2011</td>
<td>123,456,789.00</td>
<td>Metric</td>
</tr>
</tbody>
</table>

Anti-Virus

The ECDL Foundation has provided and virus checked the Microsoft Office work files used in the PSI ECDL/ICDL tests. However, test centres are advised to use updated anti-virus software on candidate machines.

Support

If you have any questions or require support, please contact your regional provider.
Appendix B: In-application Testing - Microsoft Edge

Change the Microsoft Edge default browser

The Microsoft Edge web browser provided with some Windows operating systems is not compatible with the PSI In-application Plugin. If you are using Windows 10 then please use Internet Explorer 11, which comes pre-installed.

To change the default web browser from Microsoft Edge to Microsoft Internet Explorer, follow the instructions below:

1. Within the search field type: default browser and press Enter
2. Then click Choose a default web browser from the top of the search results
3. Press Default apps
4. Then under the Web browser section press **Microsoft Edge**

5. Press **Internet Explorer**

6. **Internet Explorer** is now the default web browser within Windows 10

**Please note** that this procedure can also be used to change the default web browser to an alternative browser, such as Firefox or Chrome.
Appendix C: In-application Testing - Other Microsoft Office Application Settings

The following settings in Microsoft Office applications should be applied by the test centre prior to an ECDL/ICDL test.

Microsoft Office 2016

Interface Settings for Microsoft Word 2016

The Status Bar must display **Sections**.

User Interface Settings for Microsoft Excel 2016

The **Compare and Merge Workbooks** icon must be available on the Quick Access toolbar for use during a test.
Interface Settings for Microsoft Word and Excel 2016

The **Developer** tab must be turned on.

Macro Security Settings for MS Word, Excel and PowerPoint 2016

The **Trust access to the VBA project object model** box must be checked.
Macro Security Settings for Microsoft Access 2016

1. Go to File menu > Options > Trust Center
2. Click Macro Settings
3. Check Enable all macros

Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access 2016 (Optional)

To remove the blocked content message appearing on the message bar for Microsoft Word, Excel, PowerPoint and Access, take the following steps:

1. Go to New document > File menu > Options > Trust Center > Trust Center Settings
2. Click Message Bar
3. Check Never show information about blocked content

**Important:** We advise that you do not change security settings in the Trust Center, as there can be consequences of loss of data, data theft, or security compromises on your computer or network.
Microsoft Office 2013

Interface Settings for Microsoft Word 2013

The Status Bar must display Sections.

![Status Bar Settings](image)

User Interface Settings for Microsoft Excel 2013

The Compare and Merge Workbooks icon must be available on the Quick Access toolbar for use during a test.

![Quick Access Toolbar](image)
Interface Settings for Microsoft Word and Excel 2013

The **Developer** tab must be turned on.

Macro Security Settings for MS Word, Excel and PowerPoint 2013

The Trust access to the VBA project object model box must be checked.
Macro Security Settings for Microsoft Access 2013

1. Go to File menu > Options > Trust Center
2. Click Macro Settings
3. Check Enable all macros

Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access 2013 (Optional)

To remove the blocked content message appearing on the message bar for Microsoft Word, Excel, PowerPoint and Access, take the following steps:

1. Go to New document > File menu > Options > Trust Center > Trust Center Settings
2. Click Message Bar
3. Check Never show information about blocked content

**Important:** We advise that you do not change security settings in the Trust Center, as there can be consequences of loss of data, data theft, or security compromises on your computer or network.
Microsoft Office 2010

Interface Settings for Microsoft Word 2010

The Status Bar must display **Sections**.

![Microsoft Word Status Bar](image1.png)

Interface Settings for Microsoft Excel 2010

The **Compare and Merge Workbooks** icon must be available on the Quick Access toolbar for use during a test.

![Microsoft Excel Quick Access Toolbar](image2.png)
Interface Settings for Microsoft Word and Excel 2010

The **Developer** tab must be turned on.

Display Any Hidden Workbooks in Excel 2010

Hidden workbooks must be displayed by choosing the **Unhide** command on the View tab.

Macro Security Settings for Microsoft Word, Excel, PowerPoint 2010

The Trust access to the VBA project object model box must be checked.
Macro Security Settings for Microsoft Access 2010

Please go to File menu > Access Options > Trust Center > Trust Center Settings > Macro Settings > Enable all macros. Failure to apply this setting will mean that not all Database content is enabled; therefore, some questions cannot be completed.

![Mcro Security Settings for Microsoft Access 2010](image)

Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access 2010 (Optional)

To remove the blocked content message appearing on the message bar for Microsoft Word, Excel, PowerPoint and Access you can take the following steps:

1. Go to New document > File menu > Options > Trust Center > Trust Center Settings
2. Click Message Bar
3. Check Never show information about blocked content

![Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access 2010](image)

**Important:** We advise that you do not change security settings in the Trust Center, as there can be consequences of loss of data, data theft, or security compromises on your computer or network.
Appendix D: Unsupported Operating Systems and Browsers

Unsupported Operating Systems

Please note that we no longer offer support for the following Operating Systems:

Microsoft Windows XP

Microsoft Windows XP ceased to be supported by Microsoft as of 8 April 2014 and therefore is not supported as an operating environment for ATLAS Cloud.

Microsoft Vista

Microsoft Vista ceased to be supported by Microsoft as of 11 April 2017 and therefore is not supported as an operating environment for ATLAS Cloud.

Unsupported Browsers

Any earlier web browser versions, other than those mentioned here, are not supported.

Safari for PC

We plan to announce official support for Safari in the near future, although this will not include the use of in-application testing.

Old Versions of Google Chrome

We do not support versions of Google Chrome prior to version 45.

Old Versions of Firefox

We do not support versions of Firefox prior to version 53.
Appendix E: Technicians Checklist

This checklist has been created to help Technicians to minimise any configuration and incompatibility issues when running tests through ATLAS Cloud.

This document supplements the system requirements check accessible via the Check System Requirements link on the ATLAS Cloud login page, as well the full system requirements document.

There is a Part 1 for all users, and a Part 2 that is required by in-application users only.

Viewing the System Requirements Check Log

When a System Requirements check is run, either before or during a test, the details of the check are retained in a log. The log is used for troubleshooting any issues that arise during the check. If you contact our Support team for assistance, it is often useful to send them a copy of the log.

You can view the log in three different ways, depending on where you are in the application.

View log link

A “View log” link is displayed on the System Requirements check results window:

View Log

Click the link to display the log details in a dialog.

Show log button

A button is displayed on the System Requirements check window.

Show log

Click the button to display the log details at the bottom of the window.

Copy logfile button

This button appears in two forms, depending on where it is displayed:

- On the System Requirements check results window:

- In the top-right of a test window, next to the End Test button:

Click this button to download a timestamped text file of the log to your local Downloads folder. You can forward the file to Support if necessary.

Do not edit the logfile before sending it to Support.
# Checklist for All Users – Part 1

The following checks are required for all users of PSI ATLAS Cloud:

<table>
<thead>
<tr>
<th>System Check</th>
<th>Requirements</th>
<th>Implications / Things to be considered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>One of the following:</td>
<td>If using Windows 10 for testing, you must use Internet Explorer version 11 or the latest versions of Chrome and Firefox, as Microsoft Edge (the default browser) is currently not supported.</td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
<td>For information on how to change the default browser in Windows 10, please see Appendix B.</td>
</tr>
<tr>
<td></td>
<td>Windows 8</td>
<td>Please note that if you use Windows 8 or Windows 10, Internet Explorer must be running in desktop mode to run the test.</td>
</tr>
<tr>
<td></td>
<td>Windows 10</td>
<td>See Checklist Supplement section - Part 2 below for more information on requirements for in-application testing.</td>
</tr>
<tr>
<td></td>
<td>(Mac users, see here)</td>
<td></td>
</tr>
<tr>
<td>Browser</td>
<td>One of the following:</td>
<td>The latest version of Chrome must be used for the item banking audio capture (speaking) test question to work.</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer version 11</td>
<td>See Checklist Supplement section - Part 2 below for more information on requirements for in-application testing.</td>
</tr>
<tr>
<td></td>
<td>Google Chrome</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Firefox</td>
<td></td>
</tr>
<tr>
<td>Disabling of pop-up blockers</td>
<td>All pop-up blocking technologies must be disabled for *.psionline.com</td>
<td>Toolbars within browsers, e.g. the Google Toolbar, can contain pop-up blockers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If adding exceptions to site lists, ensure that both the HTTP and HTTPS variants of our URL are used.</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>Download speeds of at least 512Kbit/s per user are required with no less than 10 Mbit/s of total capacity</td>
<td>See Checklist Supplement section - Part 2 below for more information on requirements for in-application testing.</td>
</tr>
<tr>
<td>Firewall configuration</td>
<td>ATLAS Cloud uses:</td>
<td>HTTP and HTTPS traffic must be allowed from *.psionline.com since ATLAS Cloud uses both.</td>
</tr>
<tr>
<td></td>
<td>HTTP (Port 80)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HTTPS (Port 443)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DNS Lookups (port 53 TCP/UDP)</td>
<td></td>
</tr>
<tr>
<td>MIME types</td>
<td>.BIN files</td>
<td>Downloading of .BIN and .JAR files must be permitted from both HTTP and HTTPS addresses.</td>
</tr>
<tr>
<td></td>
<td>.JAR files</td>
<td>http://*.psionline.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>https://*.psionline.com</td>
</tr>
</tbody>
</table>

## Support

For in-application testing please continue to carry out supplementary checks in Part 2 below. For anyone else, if all the steps in the checklist are followed but you cannot use ATLAS Cloud successfully, please contact your support provider.
Supplementary Checks for In-application Testing only – Part 2

For in-application testing, the following checks need to be taken in addition to those in Part 1:

<table>
<thead>
<tr>
<th>System Check</th>
<th>Requirements</th>
<th>Implications / Things to be considered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>One of the following: Windows 7, Windows 8, Windows 10</td>
<td>Only Microsoft Windows operating systems can run an in-application test (Mac users, see <a href="#">here</a>)</td>
</tr>
<tr>
<td>Browser</td>
<td>One of the following: Internet Explorer version 11, Google Chrome, Firefox</td>
<td>To use our testing system with any of these browser options, a plugin is required. For installation instructions please see <a href="#">Appendix F</a></td>
</tr>
<tr>
<td>Plugin installation</td>
<td>The PSI In-application Plugin is required for in-application tests</td>
<td>All Supported Browsers: Ensure the plugin is fully installed, and detected. (instructions are listed in <a href="#">Appendix F</a>) Additional Chrome Requirements: Ensure the extension has been installed (see <a href="#">here</a>) Additional Firefox Requirements: Ensure the Firefox extension and the new plugin are installed (see <a href="#">here</a>)</td>
</tr>
<tr>
<td>.NET Framework</td>
<td>.NET 3.X is required</td>
<td>The .NET 3.X framework must be installed for tests to operate. For a download link, please see <a href="#">Appendix A</a></td>
</tr>
<tr>
<td>Microsoft Office</td>
<td>A Microsoft Office installation is required</td>
<td>For information on the versions of Microsoft Office that are supported, see <a href="#">Appendix A</a> For instructions on configuring Office see <a href="#">Appendix C</a></td>
</tr>
<tr>
<td>Printer configuration</td>
<td>A default printer is required</td>
<td>For instructions on how to configure a default printer, please see <a href="#">Appendix A</a></td>
</tr>
<tr>
<td>Access to work-files (Z:/)</td>
<td>ATLAS Cloud uses a drive-mapping script to create a Z:/ on the machine which is used to store test work-files</td>
<td>This script should not be blocked by any Group Policy or process The mapped drive must be visible to candidates and no GPO should hide either unused drives or specifically the Z:/ drive letter. If Z:/ is already mapped on your network, the script will use the next available letter going backwards until an available letter is found. Test candidates must have access to this drive once created.</td>
</tr>
<tr>
<td>Registry access</td>
<td>Users must have read/write access to settings under HKEY_CURRENT_USER</td>
<td>This access is the default configuration in Windows. If restrictions have been introduced, they must accommodate this requirement</td>
</tr>
<tr>
<td>Demo test</td>
<td>A demo test should be run to confirm successful configuration prior to using ATLAS Cloud for live testing</td>
<td>To access demo content, login to ATLAS Cloud, click on your name in the top right-hand corner of the screen and click “Catalogue”. Underneath “Demo content” you will find a series of tests that can be used to test your ATLAS Cloud setup. Successful completion of one of these tests will indicate appropriate configuration of the machine and profile.</td>
</tr>
</tbody>
</table>
In-application Testing Support

If all the steps in the checklist Part 1 and 2 are followed and a demo test does not run successfully, please contact your support provider.

Test Runtime Errors

In the event of a test malfunction whilst running the test, errors will manifest themselves as follows:

If this message is displayed, click the download button to save a .SUPPORT file to your desktop. Please email this file to your support provider to enable an in-depth analysis of the problem.
Appendix F: Plugin Guide (In-application tests only)

This appendix describes the steps required to install the PSI In-application Plugin.

The PSI In-application Plugin is intended for use with the most up to date versions of Internet Explorer, Google Chrome, and Mozilla Firefox. Please see here for the supported versions.

The processes for installing the PSI In-application Plugin are slightly different depending on the browser used. For Chrome and Firefox users only, additional steps are necessary to install a Chrome extension and Firefox extension respectively.

It is possible to install the PSI In-application Plugin, either prior to testing outside of ATLAS Cloud®, see here, or just before a test in the System Requirements Check page for in-application tests, see here.
Installing the PSI In-application Plugin prior to Testing

This guide is designed for system administrators intending to prepare workstation(s) for candidate(s). The PSI In-application Plugin MSI can be deployed to workstations in a network using proprietary deployment software, if available, or manually to individual machines using the following instructions.

1. Download the `PSIIAPLugin.msi` installation file from [here](#). Please note, if you are not using a `*.psionline.com` address then this version of the plugin may not function correctly. If this is the case, please use the appropriate `*.psionline.com` domain address.

   Alternatively, you can access the plugin from the Download button on the Check system requirements page or the Download link shown when running a system requirements check (this process is covered [here](#)) as shown below.

   Alternative methods to access the Plugin extension prior to testing:

   ![Download button on the Check System Requirements Page](#)

   ![Download link when running the system requirements page](#)

2. You will receive one or two messages to verify you wish to run the installation.

   The message will ask to **Run** or **Save** the installation.

3. To run the installation straight away, click **Run**.

   Please note that you can also **Save** the file to a chosen location on the machine and then run the installation from there.
4. Press the **Next** button
The installation starts and a status window is displayed.

![Status window](image)

A message may appear requiring permissions to be enabled to complete the installation.

⚠️ Please note that this message may be hidden. If this is the case, please look on the taskbar to access the message.

5. Press the **Yes** button.
A message will appear to show that the Setup Wizard is complete.

6. Click the **Finish** button.

![Setup Wizard Complete]

**Internet Explorer**

The PSI In-application Plugin installation procedure is now complete for **Internet Explorer** users.

⚠️ Please note that Google Chrome and Mozilla Firefox users must continue to the next sections ([Installing the Google Chrome Extension prior to testing](#) or [Installing the Mozilla Firefox Extension prior to testing](#)), to complete the installation process.
Installing the Google Chrome Extension prior to testing

As well as downloading the installation file, **Google Chrome users** must add an additional extension.

The method below is for installing the extension prior to testing.

⚠️ Please ensure that the PSI In-application Plugin is installed **before** you add the extension to Chrome

1. Copy and paste the following **URL** into the address bar:

   https://chrome.google.com/webstore/search/psi%20in-application?_category=extensions

   Alternatively, you can access the URL from the **Add to Chrome** button on the **Check system requirements page** or when actually running a system requirements check (via the ATLAS Cloud login page) as shown below

Alternative methods to access the Chrome extension prior to testing:
The PSI In-application Extension install window will appear

2. Click on the **ADD TO CHROME** button

3. Press the **Add extension** button

Once the extension has been added to Chrome, a confirmation message will be displayed as shown in the screenshot below:
The Chrome extension installation is now complete.

✅ Chrome

The PSI In-application Plugin installation procedure is now complete for **Google Chrome** users.
Installing the Mozilla Firefox Extension prior to testing

As well as downloading the installation file, Mozilla Firefox users must add an additional extension.

⚠️ Please ensure that the PSI In-application Plugin is installed before you add the extension to Firefox.

1. From the ATLAS Cloud login page, select the Check System Requirements link

![ATLAS Cloud login page](image-url)
2. Click on the **Add to Firefox** button

Alternatively, you can access the extension from the **Add to Firefox button when running a system requirements check** as shown below. The full steps using this method are covered [here](#).

Alternative method to access the Firefox extension prior to testing:

**Add to Firefox button when running Check System Requirement**

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Windows</th>
<th>OK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Resolution</td>
<td>1366x768</td>
<td>OK</td>
</tr>
<tr>
<td>Browser</td>
<td>Firefox 51</td>
<td>OK</td>
</tr>
<tr>
<td>Popups</td>
<td>Enabled</td>
<td>OK</td>
</tr>
<tr>
<td>Tabbed Browsing</td>
<td>Disabled</td>
<td>OK</td>
</tr>
<tr>
<td>Plugin</td>
<td>No extension detected</td>
<td>ERROR</td>
</tr>
</tbody>
</table>

The System Requirements are also available in PDF format: Download

Download the PSI In-application Plugin: Download

Install the PSI In-application Extension for Firefox: Add to Firefox
3. Press the **Allow** button

![Screenshot of the Allow button](image1)

4. Press the **Install** button

![Screenshot of the Install button](image2)

Once the extension has been added to Firefox, a confirmation message will be displayed, as shown in the screenshot below:

![Confirmation message](image3)

The Firefox extension installation is now complete.

![Firefox installation complete](image4)

The PSI In-application Plugin installation procedure is now complete for **Mozilla Firefox users**.
Installing the PSI In-application Plugin at the time of Testing

This section is designed for anyone who needs to install the PSI In-application Plugin when launching a test via the System Requirements page.

It is recommended that the In-application Plugin installation is carried out prior to any testing. However, in some cases a System Requirements Check shows that the plugin has not been installed, and therefore the test will not launch. If this happens, a candidate can install the plugin themselves via the System Requirements page.

Please note that only in-application tests require the plugin, and therefore will allow the plugin to be downloaded from the System Requirements Check page.

Once a test has been opened from the Catalogue page, the System Requirements Check is carried out. If the In-application Plugin is not available an error will show in red, as seen below.

The plugin must be downloaded to carry on with testing.

1. Click the Download link.

Please note that Internet Explorer and Firefox users will not see references to Chrome or the extension shown above. However, Firefox users will require an extension, which is covered later in this document.
2. Once the download is complete, click the **PSIIAPlugin.msi**

3. Click the installation file, as highlighted above, and press the **Run** button
4. Press the **Next** button

![Installation window]

The installation will start and a status window is displayed.

![Status window]

A message will appear requiring permissions to be enabled to complete the installation.

Please note that this message may be hidden behind the installation message. If this is the case, it can be accessed via the Security shield icon that will appear on the taskbar.
5. Press the **Yes** button.

A message will appear showing that the Setup Wizard is complete.

6. Click the **Finish** button

Internet Explorer users can now press F5 to update the system requirements check and show that the Plug in is installed OK
The PSI In-application Plugin installation procedure is now complete for Internet Explorer users and they will see the screen below.

![Running System Requirements Check](image)

Please note that Google Chrome Users must continue to the next section Installing the Google Chrome Extension at the time of testing to complete the installation process. Firefox users must continue to the section Installing the Mozilla Firefox Extension at the time of testing to complete the installation process.
Installing the Google Chrome Extension at the time of testing

As well as downloading the installation file at the time of testing, Google Chrome users **must** add an additional extension.

Once the PSI In-application Plugin installation is complete, the Google Chrome user will be taken back to the System Requirements Check page and will see that an *Add to Chrome button* is available.

1. **Press the Add to Chrome button**

   ![Add to Chrome button](image)

   A message will appear to show that you will need to access the Chrome web store.

2. **Click the OK button**

   ![OK button](image)
3. Press the **Install Extension** link

![Running System Requirements Check](image)

The PSI In-application Extension install window will appear.

4. Click on the **ADD TO CHROME** button

![PSI In-application Extension](image)
1. Press the **Add extension** button

After the extension has been added to Chrome, a confirmation is displayed:

**PSI In-application Extension has been added to Chrome.**

5. **Refresh the browser by pressing F5**

The installation procedure is now complete for **Google Chrome users**
Installing the Mozilla Firefox Extension at the time of testing

As well as downloading the installation file at the time of testing, Mozilla Firefox users must add an additional extension.

Once the PSI In-application Plugin installation is complete, the Mozilla Firefox user will be taken back to the System Requirements Check page and will see that an Add to Firefox button is available.

1. Press the **Add to Firefox** button

2. Press the **Allow** button
3. Press the **Install** button

After the extension has been added to Chrome, a confirmation message is displayed:

![Install button](image)

4. Refresh the browser by pressing F5

![Running System Requirements Check](image)

This check shows if the system requirements for the test are met. Links to more detailed explanations will be shown if there are any errors.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>OK</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>OK</td>
</tr>
<tr>
<td>Browser</td>
<td>OK</td>
</tr>
<tr>
<td>Popups</td>
<td>OK</td>
</tr>
<tr>
<td>Tabbed Browsing</td>
<td>OK</td>
</tr>
<tr>
<td>Plugin</td>
<td>OK</td>
</tr>
</tbody>
</table>

**Firefox**

The installation procedure is now complete for Mozilla Firefox users.